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1 Introduction
Thank you for buying LineFollower, our Arduino-compatible line following robot. We hope it will
give you as much joy as we had designing it.
We would be delighted to hear from you about any of your projects and about your experience with
our robots. You can contact us directly via e-mail (support@aiva-robotics.se) or give us a call. Tell us
what we did well, what we could improve and what you would like to see in the future.

1.1 About Aiva Robotics
Aiva Robotics is a Swedish-based robotic company and was founded 2014. It is owned by Jonas
Jarvoll and focus to offer well-engineered and high quality robotic products, both for use in
professional engineering, maker and education industries.
Site:

http://www.aiva-robotics.se

E-mail:

info@aiva-robotics.se

Phone:

+46 76 103 74 70

Address:

Aiva Robotics
Mor Kerstins v 46
511 56 Kinna
Sweden

1.2 About Arduino
Arduino is an open-source electronics prototyping platform based on flexible, easy-to-use hardware
and software. It's intended for artists, designers, hobbyist and anyone interested in creating interactive
objects or environments. For more information please go to the site arduino.cc.
We at Aiva Robotics love the Arduino concept and to show our appreciation and give something back
to the community we yearly donate money to the foundation.

1.3 Prerequisites
This user guide will not teach you how to program and assumes that you have some basic knowledge
about computers in general. If you want to start a career as robot programmer or have a lot of spare
time, we cannot think of a better way than using this robot as a starting point. There are several very
good tutorials about Arduino on the Internet and with some persistence (yes, we are sorry to say that
robotics requires a bit of patience to learn even if we have tried to make it as easy as possible for you)
you will soon experience the joy of seeing your robot come to life!

1.4 License
We strongly believe in open-source. Therefore are all our software for our products released under the
GPL and the C/C++ microcontroller libraries are under LGPL unless otherwise stated in the files. The
schematic and layout files for the hardware is released under the Creative Commons Attribution
Share-Alike license. This basically means that you are not only free to use our software and hardware
but encouraged to make changes to it and share your result with rest of the world.
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1.5 Version history
Version
A

Date
2015-07-26

Changes
First version
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2 Safety
The robot is not designed for young children and requires adult supervision. By using this product, you
agree not to hold Aiva Robotics liable for any injury or damage related to the use or to the
performance of this product. This product is not designed for, and should not be used in, applications
where the malfunction of the product could cause injury or damage. Please take note of these
additional precautions:
•

•

•

•

The robot is intended for use indoors on relatively flat, smooth surfaces. Avoid running your
robot on surfaces that might scrape or damage the underside of your robot’s PCB as it drives
around.
Avoid placing the robot so that the underside of the PCB makes contact with conductive
materials (e.g. do not place the robot in a bin filled with metal parts). This could inadvertently
short out the batteries and damage your robot, even with the robot turned off. Shorting various
pads or components together could also damage your robot.
Since the PCB and its components are exposed, take standard precautions to protect your robot
from ESD (electrostatic discharge), which could damage the on-board electronics. When
picking up the robot, you should first touch a safe part of the robot such as the wheels, motors,
batteries, or the edges of the PCB. If you first touch components on the PCB, you risk
discharging through them. When handing the robot to another person, first touch their hand
with your hand to equalize any charge imbalance between you so that you don’t discharge
through the robot as the exchange is made.
The robot is capable of driving very fast so even if it is light-weight it could cause significant
damage to objects, animals and people. Always be prepared to stop the robot if it starts to go
berserk and never ever run the robot without supervision.
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3 Overview
This is a small but very fast line following robot. The robot is based on ATMega32U4 running at 16
MHz, powerful enough for handling many different type of line following algorithms and still have a
lot of power left to do other things. The microcontroller is preloaded with the Arduino Leonardo
bootloader making it directly programmable from the Arduino IDE. Using the prebuild library you can
have a fully functional line following robot with only a few lines of code. All pins that are not directly
used by the robot is available in standard 2.54 mm headers and there are two areas for you to solder
your own components, making it very easy to expand the functionality of the robot. The 5 reflective
sensors mounted under the board makes the line detection both precise and effective.
This manual and the software library are available from the LineFollower homepage, please go to
http://aiva-robotics.se/?q=node/7.

Rear expansion header
Communication LEDs
USB connection

ISP

Reset button
User button
User LED
Power switch
Power on LED
Battery header
Front expansion
header

3.1 Communication LEDS
The RX and TX communication LEDs on the board will flash when data is being transmitted via the
USB connection to the computer.

3.2 USB connection
The mini USB connection is used when programming the robot from the Arduino IDE. Use a standard
mini USB B cable.
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3.3 ISP
The ISP (In-System Programming) header can be used if you wish to program the robot without using
the Arduino IDE. An external programmer is required.

VCC

MOSI

MISO SCK

GND

Reset

3.4 Reset button
This button will reset the board. If you have trouble downloading a sketch you could try and make a
reset before you start the download.

3.5 User button
This button is for your usage. It is connected to the digital pin number 6.

3.6 User LED
This LED is for your usage. It is connected to the digital pin number 13. The Arduino bootloader uses
this LED to indicate that it is in bootloader mode by slowly pulsing the LED.

3.7 Power switch
Switch to turn on and off the robot.

3.8 Power on LED
The LED will be lit when the robot is powered on.

3.9 Battery header
This is the header for a battery. The distance between the pins is 2.54 mm. Make sure that you check
the polarity before you turn on the robot.

3.10 Rear expansion header
This header allows you to expand the functionality of the robot. Four digital I/Os are available plus
VCC (5V) and GND. A total of no more than 100 mA should be drawn from the front and rear
expansion headers.

3.11 Front expansion header
This header allows you to expand the functionality of the robot. One digital I/O is available plus VCC
(5V) and GND. A total of no more than 100 mA should be drawn from the front and rear expansion
headers.
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3.12 Recommended power supply
The maximum recommended voltage is 9V. This is mainly due to heat built up in the voltage regulator
(named U8 in the image below) and reduced life length of the motors. Using adequate cooling you can
increase voltage above 9V.
A 9V battery (PP3) is a good battery candidate but since it can be hard to find high-quality 9V
batteries, you are probably better of using a standard RC LiPO battery running at 7.4 V. Since the
robot normally only shall follow the line for less than a minute or so, a few hundreds mAh will
provide plenty of running time for the robot.
During development we strongly recommend that you use a grid-attached power supply unit rather
than batteries to avoid issues that can occur e.g. if you run out of power while downloading new
sketch. From a environmental point-of-view, it is also good to avoid batteries.
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Before you let your robot drive make sure the battery is firmly attached to the PCB. Use Velcro tape,
double-coated adhesive tape, rubber bands or something similar and take advantage of the slots and
holes in the PCB (see image below).
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5 How does it work?
The robot detects the line using 5 infrared reflective object sensors. The sensors are located under the
robot in the front as seen in the image below.

Right most sensor

Left most sensor

The sensor works by sending out infrared light (IR), the same kind of light used by remote controls for
e.g. TV. IR is invisible to the human eye but using the camera on your mobile phone you can get a
visible image of the light.

Active IR light (photographed
using a mobile phone)

The light gets reflected by the surface underneath the sensor. If the surface is very bright (e.g. white)
more light will be bouncing of the surface. A dark surface will on the contrary, only allow small
amount of light to bounce back. The amount of light that bounced back is converted to an electrical
signal by the sensor. This signal is then read by the analog input of the microcontroller.
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Black surface -> Less
light bounces back

White surface -> More
light bounces back

The higher value you read from the analog input the less light has been detected. A value of 1023
(max) indicates that no IR light at all was detected and a value 0 means that all light was reflected.
Both these values are extreme values and will most likely never occur in reality. A more realistic case
is that a white surface will return a value between 200 and 260 and a black between 900 and 1000.
By reading all 5 sensors and check which sensor returns the highest value you can figure out where the
black line is but there are many other more or less intelligent algorithms to detect the present of the
line. The library uses a special algorithm where the estimate is made using a weighted average of the
sensor indices multiplied by 1000. A return value of 0 indicates that the line is directly below sensor 0,
a return value of 1000 indicates that the line is directly below sensor 1, 2000 indicates that it’s below
sensor 2, etc. Intermediate values indicate that the line is between two sensors.
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6 Specification
Microprocessor

ATMega32U4

Flash

32 KB (4 KB is used by the bootloader)

RAM

2.5 KB

EEPROM

1 KB

PCB Size

99 x 93 mm

Weight

57 g (battery not included)

Power supply

LEDs

6 to 16 v (recommended max 9V, due to
heat issue)
~120mA@6 V, no motors active
~250ma@6V, both motors maximum
speed, no load
Power, TX, RX, D13

Motors

12 mm micro motors 200 RPM@6 V

Reflective sensors
Distance between sensors

5 pcs QRE1113 mounted under the
robot
10 mm (center to center)

Recommended line width

15-20 mm

Wheels

32 x 7 mm Pololu wheels

Motor driver

TB6612FNG

Current consumption
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7 Software
7.1 Programming
The robot can be programmed with the Arduino software. Select "Arduino Leonardo" from the Tools
> Board menu. The ATMega32U4 comes preinstalled with a bootloader that allows you to upload
new code to it without the use of an external hardware programmer. It communicates using the
AVR109 protocol. You can also bypass the bootloader and program the microcontroller through the
ISP (In -System Programming) header but that requires a external programmer.
Make sure that Arduino IDE and the Arduino Leonardo drivers are installed on your computer before
connecting the robot. The drivers can be found on the Arduino site (arduino.cc).

7.2 Library
The library available for the robot makes it a breeze to interface with all of its integrated hardware. To
start using the library you need to first import it in the Arduino IDE by selecting Sketch > Import
library. Click on the ZIP-file containing both the actual library and the example sketches. You don´t
need to unzip the file. The library has several functions that helps you create your first sketch for the
robot, please see next chapter for details.

7.3 Sketch
A couple of sketches for a line follower robot is included with the library. If the library was
successfully installed you can find the sketches under File > Examples > LineFollower. The sketches
are complete and you can use them to make your robot follow a black line. Note that the sketches do
not use the maximum speed of the robot leaving it up to you to optimize the sketches to take full
control of the robot and making it to a winner in line following competitions.

7.4 Overview
Even though the sketches uses different type of line following algorithms, the basic handling of the
robot is the same.
When the robot is powered on the user LED will periodically flash 3 times indicating that the robot
has not been calibrated yet. Pressing and releasing the user button will start a calibration. The robot
will start spinning for a few seconds and makes the calibration calculations. Make sure that the robot
has access both to the black line and the area outside the line. This will ensure that you get the very
best calibration possible.
When the calibration is done the robot will stop spinning and the user LED will blink slowly. Put the
robot back on the line and press the user button to make the robot follow the line. The robot will keep
follow the line until you power off the robot or press the user button again.

7.5 Simple line following algorithm
The simple line following sketch is based on a quite easy algorithm. The value returned by the
function readLinePosition() is checked against 3 different cases:
1. If the value is lower than 1500 then the robot turns to the left.
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2. If the value is between 1500 and 2500 then the robot goes forward.
3. If the value is higher than 2500 then the robot turns to the right.
This is then repeated until the robot is turned off.

7.6 PID
The line following algorithm in the PID sketch is based on a PID controller. PID stands for
Proportional-Integral-Derivate and is widely used in industrial control systems. It gives a much more
smoother response than the simple line following algorithm. You can read more about PID controller
on the Wikipedia (https://en.wikipedia.org/wiki/PID_controller). The calculations are done in the
function named doLineFollowAlgorithm(). The heart of the calculation is the following code
line:
int power_difference = proportional/10 + derivative*8 + integral/8000;

It combines the 3 terms (proportional, derivation and integration) of the PID controller and uses the
outcome of the calculation to decide how much power should be allocated to left and right motor.
By altering the factors (/10, *8 and /8000) you can make the robot follow the line more or less straight
on. Finding the best factors requires a lot of trial & error so please don´t give up too early. The
numbers in the example is a good starting point and change the factors with small steps.
Remember, in the end you want a robot that follows the line as close as possible to minimize the
distance it travels and thus reduce the time it takes to get to the end of the track, increasing your
chances of winning!
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8 Library
Here follows a complete description of all the functions found in the library.

8.1 Constructor
LineFollower()
The constructor will automatically set up all variables and hardware pins required by the functions in
the library.

8.2 Calibration functions
void calibrationClear()
Clears the previous calibration.
void calibrateStart()
Initiate a new calibration. Note that you need to call calibrateNext() in a loop for a couple of
seconds to get a good calibration. The robot needs access to both the line and the area around the line
to do a good calibration.
void calibrateNext()
When this function is called the robot makes a sensor read and established the maximum and
minimum values of each sensors. This information is used to calibrate the robot. Calling this function
periodically while the robot is moving results in the best kind of calibration.
Note: Before calling this function you need to call calibrateStart().
boolean calibrationIsValid()
Returns true if the robot has been calibrated else false.
Note: This function doesn't check the quality of the calibration, only if there has been a calibration or
not.
void calibrationLoad(int eepromAddress)
Loads calibration data from the eeprom from the address given by the parameter.
void calibrationSave(int eepromAddress)
Saves calibration data to the eeprom to the address given by the parameter.

8.3 Motors
void setLeftMotor(int speed)
Set the speed of the left motor. Valid values for speed is between -255 and 255. Zero (0) will stop the
motor. A negative number will make the motor spin backwards and positive forward.
void setRightMotor(int speed)
Set the speed of the right motor. Valid values for speed is between -255 and 255. Zero (0) will stop the
motor. A negative number will make the motor spin backwards and positive forward.
void setMotors(int leftMotorSpeed, int rightMotorSpeed)
Shorter way to set the speed for both left and right motor.

8.4 Sensors
void setLED(boolean active)
Turns off or on the user LED.
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float readBatteryLevel()
Returns the current battery voltage in V. Note that the function only returns a approximately value due
to component tolerances.
boolean readButton()
Returns true if the user button is pressed else false.
int readLinePosition()
Reads the sensors and returns the line position using a clever algorithm. It will return 0 for left most
line or 4000 for right most line, see table below (the orange dots are the sensors and the black
rectangle represents the line). The robot must have been calibrated or the result will be invalid.
The function remembers the last known line
position so if the robot loses the line this function
will continue indicate the direction to reacquire
the line. If the last position of the line was to the
left it will return 0 and if the last known position
was to the right it will return 4000.

Function will return approximately 0.

Function will return approximately 1000.

Function will return approximately 2000.

Function will return approximately 3000.
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Function will return approximately 4000.
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9 Appendix A, Schematic
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10 Appendix B, PCB layout
10.1 Top view
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10.2 Bottom view
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11 Appendix C, Bill of Materials
RefDes

Value

Name

Quantity

Comment

C1, C9

1uF

CAP_0805

2

C2, C3, C8, C10,
C11,C12,C13
C4, C5

0.1uF

CAP_0805

7

10uF

2

C6, C7

4.7uF

CAPAE5.3x5.3h6.1
CAP_0805

C14

0.01uF

CAP_0805

1

C15, C16

18pF

CAP_0805

2

Bypass capacitor for LP2992 (not
mounted)
Crystal capacitors

D1

Yellow

LED_0805

1

TX indicator

D2

Yellow

LED_0805

1

RX indicator

2

D3

Green

LED_0805

1

Power on

D4

Yellow

LED_0805

1

User LED

IC1

TB6612FNG

1

Motor H-bridge

J1

Mini USB B

1

JP1

AVR PROG

1

6 pins ISP

JP2,JP3

IDC_8pins

2

Front/rear connectors (not mounted)

JP4

IDC_2pins

1

Battery input

JP6

IDC_3pins

1

Expanding IO port front (not mounted)
Expanding IO port rear (not mounted)

JP7

IDC_6pins

1

L1

100uH

IND_0805

1

M1,M2

100rpm@6V

Micromotor

2

R1

10k

RES_0805

1

R2, R3, R4, R5

1k

RES_0805

4

R6, R8, R10, R12, R14

47k

RES_0805

5

R7, R9, R11, R13, R15

220

RES_0805

5

R16

8k2

RES_0805

1

Battery voltage level

R17

18k

RES_0805

1

Battery voltage level

R18, R19

22

RES_0805

2

USB resistors

S1

kan0442-0252c

1

Micro switch for reset

S2

kan0442-0252c

1

Micro switch for user

S4

7201MD9AQE

1

Micro power slide switch

U1, U2, U3, U4, U5

QRE1113

5

U6

ATMega32U4

1

U8

LP2992

1

Y1

16MHz

Crystal

1

PCB

1

Pololu 32 x 7 mm

Wheels

2

Pololu 3pi ballcasters

Ball casters

2

Motor brackets

2
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12 Appendix D, Pin mapping
Name

Processor pin

Arduino

Usage/Note

AIN1

PB4

D3

Direction of motor 1

AIN2

PB7

D2

Direction of motor 1

BIN1

PD0

D8

Direction of motor 2

BIN2

PD1

D11

Direction of motor 2

M1PWM

PB5

D10

M2PWM

PB7

D9

LFS1

PF0

A5

Hardware supported PWM signal using
timer 1 (~3.9 kHz) for motor 1
Hardware supported PWM signal using
timer 1 (~3.9 kHz) for motor 2
Reflective object sensor analog input

LFS2

PF1

A4

Reflective object sensor analog input

LFS3

PF4

A3

Reflective object sensor analog input

LFS4

PF5

A2

Reflective object sensor analog input

LFS5

PF6

A1

Reflective object sensor analog input

BATTERYLEVEL

PF7

A0

Battery level through a voltage divider

LED

PC7

D13

Userdefined LED

BUTTON

PD7

D6

Connected to user button

For your usage

PD4

D4

Available in front

For your usage

PD2

D0

Can also be used for UART RX

For your usage

PD3

D1

Can also be used for UART TX

For your usage

PC6

D5

For your usage

PE6

D7
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